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Get Started  

Introduction 

About the Breeding Management System 
Breeding Management System (BMS) is an information management system developed by the Integrated 

Breeding Platform to help breeders manage the breeding process, from program planning to decision-making. 

The BMS suite of tools supports multiple breeding strategies: fmns 

 Conventional breeding 

 Marker-assisted selection 

 Marker-assisted recurrent selection 

 Marker-assisted backcrossing 

The BMS package contains 

 Software needed to run BMS 

 Crop databases preloaded with germplasm characterization for priority crops and empty databases 

without preloaded information for additional crops 

 Instructions, tutorials, and other documents to help you install and use the BMS 

System Requirements 
At present you can download the Breeding Management System (BMS) package from the internet or you can 

request a copy on DVD. To run the BMS, you will need a personal computer running the Microsoft Windows 

operating system (XP or a more recent version). The Workbench runs in a web browser (e.g. Internet Explorer 

or Firefox), but you do not need to be connected to the internet to run the BMS. A web-based version will soon 

be available for users who have high-speed access to the internet. 

Minimum system requirements 

 2 GB RAM 

 1 GHz dual core 

 250 GB hard disk 

Recommended system requirements 

 4 GB RAM 

 1 GHz dual core 

 500 GB hard disk 

Supported Browsers 

 Internet Explorer 8 and above 

 Firefox 20 and above 

 Google Chrome 27 and above 

Workbench Overview 
The Workbench is the Breeding Management System (BMS) user interface, and can launch all breeding tools 

and access associated crop databases. The home page of workbench is where new programs can be created 

and previously started programs browsed and opened. The Workbench runs in a web browser, but a 

connection to the Internet is not required to run the Workbench. 
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Tools Overview 
Breeding Management System (BMS) tools are applications that run on your local computer to assist and 

inform program development. Tools can be categorized by (1) database integration and (2) stand-alone 

capabilities. All tools can be launched from the Workbench, but some tools function as stand-alone 

applications independent of the Workbench and the databases. 

Database Integrated Tools 

The Breeding Management System (BMS) contains database-integrated tools that seamlessly connect to the 

crop database when launched from an established Workbench program.  Database integration minimizes the 

need to manually create, save, and import files as you move through a breeding program.  When these tools 

are launched through the Workbench, selected data moves seamlessly from the database to the application. 

 Germplasm List Manager: Browse, search, and filter germplasm to create custom lists 

 Breeding Manager: Design crosses, advance generations, and select progeny 

 Genotype Database Manager:  Connect germplasm to genotype data 

 Nursery Manager: Design, manage, and advance nurseries 

 Trial Manager: Design and manage field trials 

 Statistical Analysis (Breeding View): Analyze phenotypic data, single site, and multi-site analyses 

 Molecular Breeding Design Tool: Select target genotypes for marker-assisted backcross breeding 

(MABC) and determine optimal population sizes for each generation 

Tools without Database Integration 
These tools, even when launched from the workbench, are not automatically preloaded with selected data. 

Data files must be created, saved, and imported into these tools. Expect these tools to be database integrated 

in future versions of the Breeding Management System (BMS). 

 Multi-Site Multi-Year Analyses 

 QTL Analysis (Breeding View): Identify quantitative trait loci 

 Molecular Breeding Planner:  Match breeding goals and crop genetic considerations to marker-

assisted breeding programs 

 Decision support tool for marker-assisted selection (OptiMAS): Generate a target genotype by 

predicting the recombination of favorable QTL into a target genotype 

Crop Database Overview 
The BMS contains databases for nine crops (bean, cassava, chickpea, cowpea, groundnut, maize, rice, 

sorghum and wheat). You can also use BMS for other crops. BMS contains empty databases without 

preloaded information, other than a few very basic traits, such as yield. 

When you install a crop database, two databases are created: 

 Public database 

 Program database 

Public Database 
The public database contains publicly available pedigree, phenotypic and genotypic data curated by a 

nominated center for each crop. For example, the International Institute of Tropical Agriculture (IITA) curates 

the cowpea database. Additionally the public database includes genetic maps for each crop based on single 

nucleotide polymorphism (SNP) markers, trait linkage information, and some public fingerprinting data. 

Genotyping with SNP markers is available from the Integrated Breeding Platform. The public database is 

preloaded with traits of relevance to each crop to help design field and nursery trials and to assist with the 

design and analysis of marker assisted breeding programs.  Users cannot make changes to the public 

database, but data can be exported as spreadsheet (.xls) files. 
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Program Database 
Program databases are accessible to program members, and data generated are automatically saved to the 

program database. BMS tools can only access one local program database at a time. Data stored in separate 

programs cannot be queried or browsed simultaneously. Single crop breeding programs will generally require 

only a single program. 

We invite users to publish program data to the public crop database; sharing pedigree and performance 

information on your germplasm accessions. If you are interested in publishing program data to the public 

database please contact support@vsni.co.uk, and you will be put in touch with the appropriate crop-center 

curator. 

Release Notes 

Overview 
Version 3.0 of the BMS is now available. This version offers significant improvements to the installation 

process, completely redesigned Fieldbook tools that are now browser-based, the introduction of seed 

inventory management features,  and a range of improvements to our existing tools.  

Installation 
With version 3.0 of the BMS, we have streamlined the installation process by offering a single installer 

option. Users will now be able to download one installer file instead of separate installers for infrastructure, 

application, and crop data. After downloading, the user can select options to install, and then the installer 

downloads all needed components and executes the installation. The single installer can be used for both new 

installations of the BMS and for updating existing installations. 

New Browser-Based Fieldbook Tools 
In version 3.0 of the BMS, the Nursery Manager and Trial Manager components of the BMS have been 

redesigned as browser-based applications that are fully integrated with the other core BMS tools in the 

workbench.  

The redesigned tools offer the following key benefits: 

 Users can move seamlessly between Fieldbook tools and others in the workbench environment 

without launching a standalone application.The user interface is consistent with other BMS tools. 

 Nursery and trial template management has been significantly improved: 

 Any existing nursery or trial in the database can be used as the template for a new nursery or trial; 

users no longer need to customize and manage Excel-based template files that reside outside the 

BMS. Basic nursery templates will be included in the database to help new users get started 

 The trial manager now supports an expanded range of experimental design types: 

o Randomized complete block designs 

o Resolvable incomplete block (also referred to as alpha lattice) designs 

o Incomplete block designs 

o Resolvable row-and-column designs (arranged in replicates) 

o Row-and-column designs (not arranged in replicates) 

 Enhanced options for exporting measurement sheets including  

o Choice of either plot or serpentine order 

o Formats compatible with a range of handheld data collection apps 
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Seed Inventory Management 
In version 3.0 of the BMS we have introduced several features allowing breeders to manage seed inventory: 

 Ability to add inventory for seed when a when a nursery is advanced 

 Ability to view available seed inventory when working with lists and making crosses, including: 

 Display of inventory levels in the list view and the individual germplasm view 

 Display of inventory locations in the list view and the individual germplasm view 

 Ability to reserve seed inventory when working with lists and making crosses 

 The BMS is compatible with legacy ICIS tools for seed storage management. Interested users 

should contact the IBP team for additional information and assistance. 

List Manager 
In version 3.0 of the BMS we have made some improvements to the List Manager, including:  

 Refinements to the user interface the List Manager to improve usability and maximize the space 

available to work with new and existing lists. 

 Ability to overwrite an existing list with changes or updates, e.g. if a user has modified an existing list 

she can now save it with the same name as the original list. 

 Seed inventory features have been integrated into the List Manager to allow the user to see stock 

levels and reserve seed for a list (see above). 

Crossing Manager 
In version 3.0 of the BMS we have made a number of minor functional improvements to the Crossing 

Manager, including:  

 Ability to select a complete existing list to use as either a male or female parent list 

 Ability to delete individual entries from the male and female parent lists, and save modified parent lists 

with the same name as the original list. 

 The display of male and female parent lists now shows the total number of entries and the number of 

currently selected entries. 

 Seed inventory features have been integrated into the Crossing Manager to allow the user to see 

stock levels and reserve seed for parent lists while planning crosses. 

Germplasm Import 
In version 3.0 of the BMS we have made improvements to the Germplasm Import tool, including: 

 Streamlining the import process to two steps instead of three and updating the the screen design to 

match other BMS tools 

 The ability to import Attributes and Stock/Inventory levels 

 The ability for users to select pedigree options when importing a list with an advanced import template 

(with GIDs included):  

o Add all entries with new records connecting to existing sources 

o Select existing germplasm wherever found 

 The user is now offered new options If the system finds matches during the import: 

o The option to ignore the match and add a new record for the germplasm instead 

o The option to remember the selected match and apply it for additional instances of the same 

GID in the import list. 

o The user can also choose to have the system accept single matches automatically if they are 

found during the import. 
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Analytical Pipelines 
The Breeding View analytical pipelines have been enhanced with the following in version 3.0: 

 The Single Site Analysis now includes new functionality to assist users with identifying outliers and 

allowing these to be excluded from the analysis 

 Summary statistics from the Single Site Analysis are now saved together with means data in the BMS 

database 

 Output reports for the Single Site and Multi-site analysis pipelines now include summary statistics. 

The BMS now includes R-AP and REML scripts that can be used for Single Site and Multi-site 

Analysis.  

GDMS 
In version 3.0, we have added the following new features to the GDMS tools: 

 Ability to handle duplicate germplasms while uploading and retrieving the genotyping data 

genotyping data upload can be done through a importing a germplasm list  

 Ability to upload MTA 

 Ability to create  haplotypes and search for lines with particular haplotypes  

 Ability to query for a region of interest e.g. all markers in the QTL region or a chromosome 

 Ability to query for a particular allele  

 Improved validation and error reporting 

MBDT 
The MBDT application is now integrated with the BMS IBDBv2 database, so that users no longer need to work 

with flat files when using this tool. 

Program Administration & General Updates 
In version 3.0, we have made the following improvements in these areas: 

 The height of the header bar has been reduced in order to maximize working space for the BMS tools 

 Users can now open nurseries and trials directly from the Home screen program folders inside the 

BMS installation folder are now named with the program name instead of a number, making it easier 

to find analysis reports and other output files 

 The Add Program process has been expanded to allow users to optionally set up favorite methods 

and locations when creating a new program 

 The Program Details, Members, Locations and Methods management screens have been 

consolidated into a single tabbed screen under the Manage Program Settings link 

 Backup files automatically stored in the Backup folder are no longer removed during the un-

installation process 

Data Import Tool 
Version 3.0 of the BMS includes several improvements to the data import tool: 

 Nurseries and trials imported through the Data Loader tool can now be opened in the new Nursery 

and Trial Manager tools 

 The Data Loader now automatically reads details about the nursery or trial from the cover sheet 

during import 

Users can now import means datasets using the Data Import tool. 
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Registration, Download, & Install 

Access Integrated Breeding Platform via the iPlant Collaborative 
The Integrated Breeding Platform (IBP) uses iPlant Collaborative to manage clients. Gain access to the 

Breeding Management System software, and all features of the Integrated Breeding Platform by obtaining a 

username and password at iPlant Collaborative (https://user.iplantcollaborative.org/register/). 

Login to the Integrated Breeding Platform with iPlant Collaborative username and password 

(https://www.integratedbreeding.net/user/login). 

 
 

Establish an IBP user profile and join community forums. 

Download and Install the Breeding Management System 
Download the BMS package after logging into the Integrated Breeding Platform with iPlant Collaborative 

username and password. 

Installation of the BMS involves: 

 Register for software 

 Download and Install BMS infrastructure files 

 Download and Install BMS Applications 

 Download and Install Selected Crop Databases 

 Download and Install Documentation Files 

Alternatively, if you have a slow or unreliable internet connection you can request a DVD of the BMS by 

contacting ibp@cgiar.org. A DVD will be mailed to you within 24 hours of your request.  

Register to Begin Download 
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Download and Install BMS Infrastructure Files 
Click the Download button to download the infrastructure installer. You may be asked to select a file directory 

for the installer or it may automatically be saved in your Downloads folder. 

 
Locate the installer file on your hard drive and double click on it to run it. A pop-up window will indicate the 

initiation of the setup. 

 

Select your preferred language from the drop-down menu and click OK. 

 

If you have previously installed the BMS, you will be asked to hoose whether you would like to update your 

existing installation or create a new installation in a different directory.  

 

  



 16 

Click Next to proceed. 

 

Read the license agreement shown in the next screen. Make sure that the 'I accept the agreement' option is 

selected.  
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Select the components you wish to install.  

 

Advanced users may choose to increase the amount of memory allocated to the installation process. 

Increasing the memory reduces the amount of time it takes for the installation to complete. If you choose this 

option, do not enter a value that exceeds the amount of RAM available on your system. Otherwise, leave the 

default value as 716 MB. 
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You will see the following screen while the installation is in progress. If you need to stop the installation, click 

Cancel; otherwise wait for the installation to complete. 

 

Click Finish to complete the installation 

Download and Install BMS Application 
Once you have downloaded and installed the BMS infrastructure, as described above, the next step is to 

download and install the BMS application. Click the Download button to start the download of this 

installer.  Depending on your browser configuration, you may be asked where you would like to save the 

installer, or it may automatically be saved in your Downloads folder. Locate the installer file on your hard drive 

and double click on it to run it. Once the installer begins, you will see a pop-up indicating that it is preparing to 

do the setup. 

 

Select your preferred language from the drop-down menu and click OK. 

Click OK to acknowledge the location of previously installed files. 

 
 

You will now see the first screen of the setup wizard. Click Next to proceed. 

Read the license agreement. Make sure that the 'I accept the agreement' option is selected, and then click 

Next. 
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Select the components you wish to install, then click Next. 

 

Choose whether or not you would like the installer to create a Start menu folder and shortcuts, then click Next 

to proceed. You may change the name of the folder from the default if you wish. 
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Choose whether or not you would like the installer to create a desktop icon for you (one will be created by 

default). 

 

If you need to stop the installation, click Cancel; otherwise wait for the installation to complete. 

 

When the installation is nearly complete, you will see the following notification that MySQL has been started, 

and that you may need to adjust your firewall settings. Click OK to continue. 
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Click Finish to complete the installation. 

 

Download and Install Crop Databases 
Once you have downloaded and installed the BMS application and the BMS support files, the next step is to 

select the crop database(s) you wish to work with, then download and install. 

 

Depending on your browser configuration, you may be asked where you would like to save the installer, or it 

may automatically be saved in your Downloads folder. 

Locate the installer file (BMS_[crop]_central_database_windows_[version].exe) on your hard drive and double 

click to run it. Once the installer begins, you will see a pop-up indicating that it is preparing the setup. 

 
Select your preferred language from the drop-down menu. Click OK to acknowledge the location of previously 

installed files. Click Next to proceed. 

Read the license agreement. Make sure that the 'I accept the agreement' option is selected, then click Next. 
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Select the components you wish to install. Click Next. 

 

Advanced users may want to increase the amount of memory allocated to the installation process. Increasing 

this allocation will make the installation quicker. If you choose to use this option, do not enter a value that 

exceeds the amount of RAM available on your system. Otherwise, leave the default value as is and click Next 

to proceed. 

 

If you need to stop the installation, click Cancel; otherwise wait for the installation to complete and select 

Finish. You have now completed the installation of your selected crop database, and you are ready to begin 

using the BMS. You can install additional crop databases to use with the BMS if you need them for your 

program. To do this, download the appropriate installer and go through this process again. 
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Download and Install Documentation 
The Documentation installer is a self-extracting archive that contains tutorials and sample files for use with the 

BMS. 

 

Locate the Documentation Installer file on your hard drive and double click on it to run it. 

Select your preferred language from the drop-down menu and click OK. 

You will now see the first screen of the setup wizard. Click Next to proceed with your installation. 

Select the components you wish to install, then click Next. 

 

Choose the location where you would like to install the documentation, then click Next. By default, it will install 

into the same directory as the BMS. 

If you need to stop the installation, click Cancel. Otherwise wait for the installation to complete. 

When the installation process is complete, click Finish to complete the installation. 
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Uninstall the Breeding Management System 
The Breeding Management System (BMS) provides tools to partly or completely uninstall the application, the 

infrastructure, and the databases. Make sure to back up your program database in another directory before 

uninstalling the BMS. 

Locate the BMS installation folder. Double click on the Uninstall file to begin the uninstall process. 

 

 Click Next on the first screen of the uninstall wizard to removing the BMS. 

 

  



 25 

Choose Between Complete or Partial Uninstall 
A partial uninstall will remove the BMS application and infrastructure, but will not remove any of the crop 

databases you have installed. This allows you to continue to use your crop databases if you reinstall the BMS 

or if you upgrade to a new version of it. The uninstall wizard will perform a partial uninstall by default, and all 

you need do is click Next. A complete uninstall will remove the application, infrastructure and any crop 

databases you installed. To choose this option, check the 'Uninstall completely' box and click Next. 

 

The uninstallation process may take a few moments to complete. 
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Once the uninstallation is done, you will see a notification that the software has been removed from your 

computer. Click the Finish button to complete the process. 

 

Launch BMS for the First Time 
After Breeding Management System (BMS) installation, launch the BMS from the Start menu or the desktop 

icon if you opt to have the installer create one for you. Unblock MySQL in your firewall if you have one 

installed. Click the OK button to launch the BMS. 
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Next, you will see the BMS start-up screen. Please note that when you launch the BMS for the first time, it can 

take several minutes for the initialization to complete move you to the log in screen. This may also occur the 

first time you launch the BMS after you restart your computer. 

 

Register as User 
The first time you use the BMS register as a network user.  This identifies you from other program members 

that collaborate on shared programs. Click on Register New Account. 
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Complete the Register User Account Form. Click the Save button to create your user account.

 

Logging Into the Workbench 
After launching, enter your username and password then click Login to enter the BMS. 

Retrieve forgotten password by selecting Forgot Your Password. Enter your user name when prompted. Click 

Next. 

 

Answer security question and click Retrieve Password. If you have answered the security question correctly, 

the system will display your password. If you do not enter it correctly, you will see an error message and will 

need to try again. 
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Home Screen 
The BMS opens to the Home screen in your default browser. The home screen of the BMS is where programs 

are added, selected, and program file directories can be viewed and modified.  

 
Home screen showing two program databases, cowpea and maize. The program, Cowpea Tutorial, is 

selected and the public list files are visible. 

Create a Program  
The Home Screen will be empty until you create a new Program database by clicking the Add a Program 

button at the top right of this panel. 

 

Basic Details 
The Basic Details tab is the only mandatory information needed to create a program. Select the desired crop 

from the drop-down menu, and enter a name for your program. The start date is set to the current date by 

default. All of the public crop databases downloaded and installed will appear in the Crop dropdown menu. If a 

public crop database was installed after launching the Workbench, the crop will not appear in the drop-down 

menu until the Workbench is re-launched. 
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If you work with a crop not supported with a public database, the BMS provides an empty database for you to 

use. Choose to Use the Generic Database and type the name of the crop you wish to work with. 

 

Save Basic Details. Select Finish to open the program or enter optional information about Members, 

Locations, and Breeding Methods. 

Manage Program Members 
Add program members by clicking on Program Members. A list of current registered Workbench users (will be 

displayed with a field to add new project members. This is an optional step. If you do not need to include 

additional members, click Finish and open your program. 
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Manage Locations 
Choose the locations used in the breeding program from the list of available locations. Add new locations as 

needed. Highlight available locations to populate the program favorites lists. Select Add to Favorite Locations 

and Save Favorites. Selected breeding locations will be available for selection during nursery and trial design.  

 

Manage Breeding Methods 
Choose the breeding methods used in the breeding program from the list of available methods. Add new 

custom methods as needed. Highlight available methods to populate the program favorites lists. Select Add to 

Favorite Methods and Save Favorites. Selected breeding methods will be available for selection during 

nursery design.  
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Finish 
Selecting finish after establishing the program settings will automatically launch the BMS workbench from the 

List Manager. 

Launch Tools and Activities for Established Programs 
Three ways to launch a program from the Home Screen. 

 Double click the selected program. 

 Double click on a specific file from the file directory 

 Select launch to open a specific selected file. 

 

Workbench Organization 
Launching a program opens the BMS Workbench where the BMS tools and administrative functions are 

located in the left hand menu.  The List Manager is the default tool that opens when a program is launched. 

 

Workbench functions are grouped by: 

 Breeding Activities 

 Information Management 

 Statistical Analysis 

 Marker-Assisted Breeding 

 Workflows 

 Program Administration 

Collapse the left side menu by selecting the <  icon next to Menu. 
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Breeding Activities 

Manage Lists 
Browse and search existing lists from the program and public databases with the List Manager. Use the List 

Manger to create and save new germplasm lists to the program database. See more on importing a 

new germplasm list. 

 

Search Lists 
Selecting Search will reveal a popup window.  Enter partial or exact list or germplasm information to find 

matching lists. 

 

Browse & Manage Files 
Selecting Browse will reveal a popup window containing a collapsible file directory of all lists, germplasm lists, 

as well as lists of Nurseries and Trials. Files are split between program database and public database 

sections. You cannot modify files in the public database. 
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Add a new folder to program lists by selecting Program Lists and the green + icon and entering a new folder 

name. 

  

Rename a program file by selecting the blue pen icon. Click OK. 

 

Delete a file from the program directory by selecting the yellow X icon. Click Yes. 
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Review List Details 
Highlight a list and double click to reveal contents. 

 

Default columns of data define Germplasm. Double click a column header to sort the list by column values. 

 Designation 

 Parentage 

 Entry Code 

 GID: Germplasm ID 

 Seed Source 

Select individual Designations or GIDs (germplasm identifiers) to reveal germplasm details. 

 

Build a New List 

Select germplasm of interest in and drag and drop the selections into the build a new list window.  
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Enter the list details. The list name must be unique to the program database. 

 

The newly created list now appears in the Program Lists file folder. The list can be renamed by selecting the 

pen icon and locked against further editing by selecting the lock icon. 

Search Germplasm 
Search by exact matches or partial matches to list names, germplasm designations, or GIDs (germplasm IDs). 

The search feature can also provide parental information. Searches are not case-sensitive. Notice that the 

Build a New List pane started in the browse list tab remains open when you move to the Search tab. 

 
A search of the cowpea database for 40398 reveals germplasm matching GID 40398 as well as the parents of 

this germplasm. Notice that GI 40398 was not found associated with any existing program database lists, only 

the public database. 
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Seed Inventory 
Review the seed inventory by selecting Inventory View from the Actions dropdown menu. 

 

Reserve seed from selected germplasm inventory view by choosing Reserve Inventory from the Actions 

dropdown menu. 

 

Specify the amount of seed to reserve.  

 

  



 38 

Make Crosses 
The crossing manager allows users to define the cross settings, choose parents, review seed inventory, 

reserve seed, and make crossing lists..   

 

Define Cross Settings 
Defining the crossing settings can be done every time a cross is made. However, most breeding programs 

only use a few crossing methods. The BMS allows you to save commonly used methods and create a list of 

favorite methods. You are also able to set a default method. 
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Design Crosses 

Select parents from established lists by dragging and dropping to the appropriate female and male parental 

lists. 

 

Save the parental lists to activate the save button on the crossing list. 

 

Review the seed inventory of the parental lists by selecting Inventory View from the Actions menu. 
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Reserve parental seed by selecting Reserve Inventory from the Actions menu in Inventory View. 

 

Choose a crossing method from the drop down menu and select whether or not to make reciprocal crosses. 

Select Make Crosses to review the crossing list.  

 

Save the crossing list and select Next. 
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Cross Summary & Export 
Select Export Cross List from Actions Menu to export crossing list as a spreadsheet (.xls) file. Select Done to 

exit this cross. 

 

Overview of Nursery Manager 
The nursery manager is a tool for designing nurseries. The nursery manager adds nurseries to the program 

database and provides the basis for developing field maps and labels to assist planting. Create data collection 

worksheets in a variety of formats, including digital recording and barcode scanning, and import back to the 

database directly. 

Create Nursery 
Launch Nursery Manager from the left side menu. Select Add a New Nursery. 

 

Enter the basic details of the nursery. Start with a blank nursery or retrieve nursery information from a 

previous nursery. Once the nursery has a name and description, the nursery details can be saved. 
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Select nursery settings. 

 Management details 

 Germplasm descriptions 

 Nursery conditions 

 Traits 

 Selection Criterion 

 Breeding Method for Advance 

 

In this nursery no nursery conditions are specified. Plants will be described with field notes. Selections will be 

described by number of plants selected. The breeding method, single plant selection, has been chosen. 
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Assign Germplasm & Checks 
Select the Germplasm & Checks tab to browse or import nursery lists and checks. 

 

Specify the details of check positions. 

 

Save Nursery 
Once germplasm and checks are saved to the nursery, field layout and labels can be designed. Data 

collection sheets are also available for printing or for download to a handheld data logger.  Any changes to the 

germplasm or checks at this point will over write the associated nursery design elements. 

 

  



 44 

Nursery Management 
After a nursery has been saved with germplasm, the Actions button reveals a dropdown menu of nursery 

management tasks. 

 

Export Nursery Book 
Select Export Nursery, and choose export format and data collection order from the dropdown menus. 

 

Export Formats 
 Excel 

 Data Kapture 

 Fieldlog/Fieldriod 

 KSU Fieldbook CSV 

 KSU Fieldbook Excel 

 R 

Data Collection Orders 
 Row/Column 

 Serpentine  Along Rows 

 Serpentine  Along Columns 

 Import Measurements 

 Select data file to import. 
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Import Selections & Observations 
Select data file to import. 

 

The data will load into the BMS. Select Save to upload the data to the BMS database. 

 

Once nursery data is loaded into the database, the associated germplasm and checks become locked. 
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Advance Nurseries 
Select Advance Nursery from the Actions button dropdown menu. 

 

Enter details about the nursery advancement. 
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Save the Advance List, which in this case is the F2 list. 

 

Update Seed Inventory 
Highlight lines of interest for seed inventory and select Update Inventory from the Inventory Actions dropdown 

menu. Enter the seed inventory details for the selected germplasm. 

 

 

Spreadsheet files can be exported from and imported into the Breeding Management System (See more on 

importing germplasm lists and trial and nursery data).  BMS files (.xls) files contain description and 

observation worksheets corresponding to germplasm lists and data from nurseries and trials. 
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Trial Management: Cowpea Tutorial 

Contributors 
Shawn Yarnes, The Integrated Breeding Platform 

Summary 
This tutorial describes the design of a three-site field trial using a randomized complete block design with 

three replicates, the export of data collection sheets, and import of field observations back to the database. 

Restore from Previous Tutorial 
Screenshots and activities in this tutorial build upon work preformed in previous tutorials. If you are not 

following the cowpea tutorials in sequence, restore the Cowpea Tutorial database (.sql) to the end of 

the previous tutorial to match database contents with current tutorial. 

BMS File Directory 

C:\Breeding Management System\Documents\BMS Workbench_Nursery & Trial 

Managers\Tutorials\Cowpea\6.0Cowpea Tutorial.sql  

Overview of the Trial Manager 
The trial manager is a tool for designing field trials.  The Breeding Management System supports randomized 

complete block, incomplete block, and row-column experimental designs. The Trial Manager uses 

standardized crop ontology terms to describe treatments, factors, and trait measurements. Access the Trial 

Manager from Breeding Activities in the workbench menu. Select Start a New Trial. 

 

Basic Details 
Enter the Trial Name, 3 Site Trial, and a Description.  Leave the default settings for the other Basic Details. 

Select Use a previously created trial as template. At any point in trial design save progress by selecting the 

Save button. 

 

Choose the Basic Trial Template from the Public Trials folder. This will populate the trial with customizable 

trial design. 
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Settings 
Under Trial Settings add a management detail not included in the template, STUDY_INSTITUTE, and type in 

UC Riverside.  Select Tim Close from the dropdown menu as the principle investigator (PI_NAME). 

 

Germplasm 
Browse for the Trial Germplasm List. 

 

Select Trial Germplasm List. 
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Review the list of 15 germplasm that will be included in the trial. 

 

Treatment Factors 
This trial will not have treatment factors, so leave empty. 

 

Environments 
This is a three location Nigerian field trial. Specify 3 environments for this trial. 
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Add the three location names, Abeokuta, Amakama, and Bauchi, and the name of the cooperating breeder for 

these locations as Issa Drabo. 

 

Experimental Design 
Choose the Randomized Complete Block Design with 3 replications for this tutorial. Select generate design to 

populate the measurements tab.   

 

Measurements 
The traits of interest in this trial are the weight of 100 seeds (g) and 50% maturity (days) (SDWT100 and 

MAT50). Review the list of traits preselected in the template.  Notice that SDWT100 and MAT50 are 

preselected. 
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At this point the trial is now ready for field mapping, label printing, and file export for data collection. Select 

Save at the bottom of the page to save the empty trial design. 

 

Export Trial Book 
Select Export Trial Book from the Actions button dropdown menu to export files for field data collection. 

 

Export Excel files corresponding all three locations to a know location on you computer and open.   

 

Restore Program 
Since each randomized trial will be different due to randomization, you must restore your program so that the 

trial design matches the tutorial's pre-formated observation files. 

BMS File Directory 

C:\Breeding Management System\Documents\BMS Workbench_Nursery & Trial 

Managers\Tutorials\Cowpea\6.1Cowpea Tutorial.sql 
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Import Trial Data 
Select Import Measurements from the Actions button dropdown menu to import field observations. Browse 

and select to the preformatted Abeokuta data. Select Import. Save the trial after import. 

BMS File Directory 

C:\Breeding Management System\Examples\Cowpea\Sample Data\3 Site Trial1-Abeokuta.xls 

 

Import of the Amakama and Bauchi location data. Save the trial after import of each data file. 

BMS File Directory 

C:\Breeding Management System\Examples\Cowpea\Sample Data\3 Site Trial2-Amakama.xls 

C:\Breeding Management System\Examples\Cowpea\Sample Data\3 Site Trial3-Bauchi.xls 

 

Confirm that the data has been upload by scrolling the to the MAT50 and SDWT100 columns in the 

measurements table and select Save. 
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 54 

File Format 

Description Sheet 
The first worksheet contains a description of the germplasm list, cross, nursery, or trial.  

 
Description Sheet: Describes a cowpea nursery 

Observation Sheet 
The second worksheet, titled Observation, contains the observation data. Column headings are specified by 

ontology terms recognized by the database. 

 
Observation Sheet: Contains the nursery information and observations 
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Information Management 

Import Germplasm  

File Format 
All BMS import and export files contain two spreadsheets: (1) Description and (2) Observation. Germplasm 

import templates require that the columns ENTRY and DESIGNATION are filled on the observation sheet. 

ENTRY is a numerical sequence and DESIGNATION is the name of the germplasm in your breeding 

program. The basic template only contains these two columns. The advanced template contains more 

columns for the import of optional geneaology data.  

BMS File Directory  

C:\Breeding Management System\Examples\Cowpea\templates\GermplasmImportTemplate-basic-rev4b.xls 

C:\Breeding Management System\Examples\Cowpea\templates\GermplasmImportTemplate-advanced-

rev4.xls 

Advanced template optional data: 

GID: Specific to the BMS database 

CROSS: Parental pedigrees (female parent/male parent) 

SOURCE 

ENTRY CODE 

 
Description sheet customized from the advanced template to include list name, description, date, and type 

 
Observation sheet with mandatory data, ENTRY and DESIGNATION, and optional CROSS and SOURCE 

information   
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Import Germplasm Tool 
The Import Germplasm tool adds germplasm lists from Excel file, with or without additional genealogy data, to 

the database by matching to existing GIDs or assigning new GIDs. (See more on importing phenotypic and 

maker data.) Importing a germplasm list ensures that each germplasm entry is assigned a GID (germplasm 

ID), which will allow pedigree and genotype tracking by the database. Browse a properly formatted Excel 

Germplasm List. Select Upload, and click Next. 

 

Review the import file data and specify the germplasm details.  

 

Select pedigree options.  

Add all entries with new records and no pedigree connections: All entries receive new GIDs with no pedigree 

connections. This option is only available using the basic germplasm template.   

Add all entries with new records connecting to existing sources: All entries receive new GIDs with pedigree 

connections where appropriate 

Select existing germplasm whenever found: Entries will be matched to the GIDs and pedigrees of 

existing germplasm whenever found. 
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Automatically accept single matches whenever found: Permit the BMS to automatically import single database 

matches without user confirmation. 

 

 

When you return to the List Manager the new list will now appear with GIDs. Positive GIDs represent matches 

to germplasm in the database.  Negative GIDs represent program-specific germplasm. 

 
One germplasm designation, CB27, matches germplasm in the database and is represented by the positive 

GID, 36820.  The other germplasm entries are new and represented by newly assigned negative GIDs. 

Manage Genotyping Data 

Export Genotyping Order Form 
Export an Excel formatted genotyping order form from the Tools button. 
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The genotyping order form will provide a plate map (96 well) of the samples that need to be prepared and sent 

to the genotype service provider.  'Subject ID' corresponds to the Entry # associated with germplasm in the 

BSM database. 'Plate ID' is the list name plus plate number.  'Well' refers to grid coordinates on a 96 well 

plate. 

 

SNP Genotype Data Format 
Sequence data will be reported back in spreadsheet format ( example file .xls) where Subject IDs (first 

columns of data) are matched to marker sequence in a genotype by marker matrix. 

 
This file of sequence data contains the sequence data from 177 germplasm accessions and 1059 SNP 

markers (marker IDs are highlighted grey). 

The DNA Assay Column will need to be more specific to upload to the database. In Excel, type the name of 

the list exactly as it appears in the BMS database followed by a dash and the Source ID.  Copy cell and paste 

down the entire column.  Excel will continue the Source IDs sequentially. The DNA Assay column is now 

replaced with the genotyping list name followed by dash Source ID. Save the modified Excel file. 
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Import SNP Genotype Data 
Open Manage Genotyping Data, and select the Upload tab. Choose the LGC Genomics SNP option. Keep in 

mind that other DNA service providers will provide similarly formatted sheets of data, so you are not limited to 

LCG Genomics data. Select the Genotyping List from the drop down menu. Choose a Dataset Name. Browse 

for the formatted file to import and select Upload. 

 

Retrieve Dataset 
Newly imported datasets can be found under the Retrieve tab. 
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Export genotyping data by selecting Dataset.  Highlight the dataset of interest, and click Next. 

 

Choose to export the dataset as a genotyping by marker matrix or as a Flapjack formatted file. 

 

Download the selected export file. 
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Browse Studies 
Select Browse Studies to browse and search the details of trials and nurseries. 

 

Use the Search tab to find studies based on date, name, country, and season.  Double click on the 

appropriate search result to open the details in the right hand pane. 
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Head to Head Query 
A head to head query allows users to compare germplasm grown in the same environment based on 

performance for a trait of interest.  The query does a pairwise comparison of the test and standard 

germplasm.  The result is based on the proportion of environments where the test germplasm surpassed the 

standard germplasm for a particular trait. 

 
 

Adapted Germplasm Query 
Find germplasm suitable for different environmental conditions using the adapted germplasm query. The 

query filters trial environments and finds the best performing germplasm for selected traits. Select Next. 
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Weight & Environments 
Choose and weight environments. 

 

Select Filter by Location to narrow environments by location or country. 
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Select Filter by Study to narrow environments by study. 

 

Add Environment Condition columns to filter table by selecting the button. 
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Select the trait filters. 

 

Display Results 
Display the results and make selections.  Click Save to List to save adapted germplasm selections in the 

database. 
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The Breeding Management System’s crop ontology management tool uses a structured vocabulary to allow 

descriptors to act as variables in database queries and statistical analyses. Crop ontology terms for research 

and traits can be browsed from the Ontology Browser. 

 

Ontology Term Details 

Select Manage Variables to examine variables further. Chose variable from the drop down menu and the 

screen will populate with variable details. 
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Select the Manage button associated with Properties and Traits to associate traits to related groupings. 

Choose a trait class from the dropdown menu to obtain a list of associated variables. 

Biotic Stress is a crop trait 

ontology term associated with the list of variables the lower right hand window.  

Manage Ontologies 

Modify Existing Terms 
Variables with the (Shared) designation are associated with the public database and cannot be 

modified.  Ontology terms from the program database, those without the shared designation, can be 

customized in numerous ways from the drop down menu. Select Update to save changes to the program 

database. 

Add New Term 
With Variable Details blank, select Manage Properties. Type a new property name and description.  Select the 

appropriate trait class from the dropdown menu and click Add.   
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A message will notify that there are no linked variables.  Select Update to save the new property and Cancel 

to close the window and return to the Manage Variables screen. 

 

Set the details for Properties and Traits as well as Methods and Scales, updating each. 

 

Once all of the details are set for the new ontology term, type a new variable name and description. Select 

Update to add the new variable to the program database.  

Be aware that the combination of variable details must be unique.  No two variables can have the same 

parameters. 
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Statistical Analyses 

Single Site Analysis: Cowpea Tutorial 

Contributors 

Shawn Yarnes 
a
, Darren Murray 

b
, Roger Payne 

b
 & Zhengzheng Zhang 

b
 

a 
The Integrated Breeding Platform, 

b 
VSN International Ltd 

Summary 
The tutorial describes the single site analysis of three locations of data from a multisite cowpea field trial using 

a completely randomized block design with 3 replicates per location.  

 Restore from previous tutorial 

 Introduction  

 Select Dataset to Analyze 

 Run Analysis 

 Analysis Results 

 References 

Restore from Previous Tutorial 
Screenshots and activities in this tutorial build upon work preformed in previous tutorials. If you are not 

following the cowpea tutorials in sequence, restore the Cowpea Tutorial database (.sql) to the end of 

the previous tutorial, Design and Management of Field Trials, to match database contents with current tutorial. 

BMS File Directory 

C:\Breeding Management System\Documents\BMS Workbench_Nursery & Trial 

Managers\Tutorials\Cowpea\7.0Cowpea Tutorial.sql  

Introduction 
Breeding Views single site analysis uses mixed models to account for extraneous sources of variation in 

breeding trials, including replicates and incomplete blocks. The single site analysis produces adjusted means, 

best linear unbiased estimators and best linear unbiased predictors (BLUEs and BLUPs) per 

genotype.  These adjusted means can be used within a genotype by environment (GxE) analysis or QTL 

(quantitative trait loci) analysis pipeline.   

Select Dataset to Analyze 
Open Single Site Analysis from the Statistical Analysis menu of the Workbench. Browse for to find the trial 

data. 
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Navigate to the Measurement Effect file within the 3 Locations Trial UCR folder. Highlight the Measurement 

Effect dataset.  There is no Measurement Effect, only ENVIRONMENT and PLOTDATA. 

 

Specify Variables 
Review the factors and traits. You will recall that only two traits, MAT50 and SDW100, were measured for this 

trial, so deselect all traits represented by empty data columns.  With only these two traits checked, select next. 

 

Specify Analysis Conditions 
 Use the default analysis name. 

 Select Randomized Block Design for the design type.  

 The factor that defines environment is SITE.  

 Select all three locations to preform individual single site analysis on each location. 

 REP is the factor in this dataset that defines replications. DESIGNATION defines the germplasm 

factor to be used in the analysis. 

Click Run Breeding View to launch the breeding view application. 
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Run Analysis 
Single site analysis is database integrated.  When the Breeding View application launches the analysis 

conditions and data are loaded. Notice that the three locations and both traits are selected. Right click on any 

trait or location to deselect from the analysis. When a project has been created or opened, a visual 

representation of the analytical pipeline is displayed in the Analysis Pipeline tab. The analysis pipeline 

includes a set of connected nodes, which can be used to run and configure pipelines. 

 

Description of Nodes 

 Quality control phenotypes: Summary statistics for the trait(s) 

 Field trial analysis: Mixed model analysis of field trial for the trait(s) 

 Export field trial results:Stores results in external files 

 Generate report:HTML report of results including means and summaries for the trait(s) 

 Export means for further analysis: Stores adjusted means in an external file using a format ready to 

use in a GxE or QTL analysis pipeline 

Analysis Options 
Some of the nodes have options to control they way an analysis is performed and output that is displayed. To 

access the options, right-click on a node and select the Settings item from the shortcut menu. The changes to 

the options are retained during the current session and are saved to the project file. 

Summary Statistics 
Default settings under Quality Control Phenotypes define the summary statistics that are displayed in the 

output. 
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Field Analysis Options 
Default settings under Field Trial Analysis define the output and iterations for optimization. 

 

Report Options 
Default settings under Generate Report define the reporting options. 

 

Analysis Results 
In this example leave the default settings and run the entire pipeline.  Right click the first box and Run 

Selected Environment Pipelines. When the analysis is complete a popup notifies the user. 
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Quality Assurance 
When the analysis pipeline is complete a Quality Assurance tab is generated. The Quality assurance tab 

displays reports of potentially influential (outlier) values for each location. Select the Bauchi environment to 

view details. 

Breeding View identifies two types of outliers: 

 Raw data outliers are observations that exceed 1.5 times the interquartile range, and can be seen on 

the accompanying boxplot. 

 Residual outliers are observations that have been reported as a large standardized residual by mixed 

model analysis. 

 

The Quality Assurance report can be used to change observations to become missing for the analysis. To do 

this, select the observations to set as missing from the list of traits, and click the Set Selected as Missing. The 

next time the analysis is run those observations will be excluded from the analysis. For this tutorial, do not 

exclude any values from the analysis. 

 

Breeding View presents box plots of the variation found in the raw data. Diagnostic plots for the mixed model 

analysis can be viewed in the Graph or Report tabs 
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Review the table of entries/genotypes that have potentially influential observations with their associated 

values, as well as other plots within the field design. 

 

Report 
The report tab includes: 

 Combined file of predicted means: Excel file of BLUEs and BLUPs 

 Links to individual trial reports 

 Heritability Table: Broad-sense mean line heritability, derived from an estimate of the correlation 

between the genotype BLUPs and their unknown true value (Cullis, Smith & Coombes, 2006). 
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Combined File of Predicted Means 
Open the combined file of predicted means in Excel or other spreadsheet program. The file contains two 

worksheets with BLUPs and BLUEs. 

 

Individual Trial Reports 
View individual trial reports with summary statistics and diagnostic plots by selecting the location of interest, in 

this case Bauchi. 

 

Save Analysis Results 
When an analysis pipeline is run, the associated files are automatically saved into the BMS workspace folder. 
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Upload the results of the analysis to the Workbench database by selecting Upload to the BMS. Once saved to 

the database, select Browse Studies from the Information Management tools on the Workbench menu to view 

study data. Notice that the trait means have now been added to the database. 
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Multi-Site (G x E) Analysis: Cowpea Tutorial 

Contributors 

Shawn Yarnes 
a
, Darren Murray 

b
, Roger Payne 

b
 & Zhengzheng Zhang 

b
 

a
 The Integrated Breeding Platform, 

b
 VSN International Ltd 

Summary 
This tutorial provides instruction on the analysis of genotype by environment (GxE) interactions within a three-

location cowpea field trial.  This tutorial builds upon the adjusted means calculated for the individual locations 

in the previous tutorial, Single Site Analysis: 3 Location Batch. 

 Restore from Previous Tutorial 

 Introduction 

 Select Data from Database 

 Run Analysis 

 Results 

 References 

Restore from Previous Tutorial 
Screenshots and activities in this tutorial build upon work preformed in previous tutorials. If you are not 

following the cowpea tutorials in sequence, restore the Cowpea Tutorial database (.sql) to the end of 

the previous tutorial, Single Site Analsysis, to match database contents with current tutorial. 

BMS File Directory 

C:\Breeding Management System\Documents\BMS Workbench_Nursery & Trial 

Managers\Tutorials\Cowpea\8.0Cowpea Tutorial.sql  

Introduction 
After single site analysis has been preformed for each location and the adjusted means are saved to the 

database, a multi-site analysis is possible to further investigate genotypic and environmental (GxE) 

interactions. 

Select Data from Database 
Open Multi-Site Analysis from the Statistical Analysis menu of the Workbench. Select Browse. 

 

Highlight and Select 3 Site Trial, which houses the previously calculated adjusted means. 
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Define the environments and groups and review the factors and variates. 

 Factors 

 Environment: SITE 

 Genotype: DESIGNATION 

 Environment Group (Mega-Environments): NONE 

Select both variates; seed weight and 50% maturity. 

 

Review the details of the dataset and launch Breeding View.  Click "Next"  By the way, this process takes way 

too long (both generating the table and launching Breeding View). 
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Run Analysis 
Mulit-Site analysis is database integrated.  When the Breeding View application launches, the analysis 

conditions and data are automatically loaded. Notice that all locations and traits are selected by default. Right 

click on any trait or location to deselect from the analysis. When a project has been created or opened, a 

visual representation of the analytical pipeline is displayed in the Analysis Pipeline tab. The analysis pipeline 

includes a set of connected nodes, which can be used to run and configure pipelines. Right click on 

MAT50_Means and exclude this trait from the analysis. 

 

Node Descriptions: 

 Quality Control Phenotypes Summary statistics within and between environments for the trait(s) 

 Finlay-Wilkinson: Performs a Finlay-Wilkinson joint regression 

 AMMI Analysis: 

 GGE Biplot 

 Variance-Covariance Modeling: Selects the best covariance structure for genetic correlations between 

environments 

 Stability Coefficients: Estimates different stability coefficients to assess genotype performance and 

generate HTML report of the results 

Analysis Options 
Some of the nodes have options to control they way an analysis is performed and output that is displayed. To 

access the options, right-click on a node and select the Settings item from the shortcut menu. Changes to the 

options are retained during the current session and are saved to the project file.  

Leave the default analysis settings. Right click on Quality Control Phenotypes to run pipeline. When the 

analysis is complete a popup window will notify you that the results are ready to view.  
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Results  
Analysis results can be found in the Output, Graphs, and Results tab. Results are also saved in the Breeding 

Management Systems workspace folder. 

Analysis Results 

 Summary statistics for seed weight within and between the environments 

 Sensitivity Calculations: Finlay-Wilkinson Joint Regression, AMMI, GGE, 

 Stability statistics: Different variance-covariance models. 

Summary Statistics 

Summary statistics from the 

Output tab showing that the Amakama site has the highest mean seed weight and that the Abeokuta and 

Bauchi sites are highly correlated. 
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Graphical display of environmental correlations: The red coloration on the heat map indicates a high 

correlation (0.8289 from table in Output) between Abeokuta and Bauchi, and small correlations for the other 

two sites. 

 
Default summary statistics options 

Finlay-Wilkinson Joint Regression 
Finlay-Wilkinson Joint Regression characterizes the sensitivity of each genotype to environmental effects by 

fitting a regression of the environment means for each genotypes on the average environmental means. In the 

estimates a value of 1 represents the average sensitivity and genotypes with a value greater than one exhibit 

higher than average sensitivity and genotypes with a value less than 1 are less sensitive than average. 

 
The Finlay Wilkinson analysis indicates that genotypes and environments are significant sources of variation 

(p = 0.004 and 0.002 respectively), but that G x E sensitivity is not significant (p=0.349). The most sensitive 

genotype is ART 91-2. 

 
Default Finlay & Wilkinson options 
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AMMI Analysis 
The AMMI analysis node fits a model which involves the Additive Main effects of ANOVA with the 

Multiplicative Interaction effects of principal components analysis (PCA). The AMMI model is more flexible 

than Finlay-Wilkinson, in that more than one environmental quality variable is explained using multiplicative 

terms. 

 
The ANOVA table for the AMMI analysis cannot be completed with variance and P values, because degrees 

freedom is limited by too few environments. 

A desirable property of the AMMI model is that genotype and environmental scores can be used to construct 

biplots to help interpret genotype-by-environment interaction. In the biplot, genotypes that are similar to each 

other are closer in the plot than genotypes that are different. Similarly, environments that are similar will group 

together as well. When environment scores are connected to the origin of the plot, an acute angle between 

lines indicate a positive correlation between environments. A right angle between lines indicates low or no 

correlation between environments, and an obtuse angle indicates negative correlation. The projection of a 

genotype onto the environmental axis reflects performance in that particular environment. 

      
Default AMMI Analysis options 

 
The obtuse angle between Amakama and both Bauchi and Abeokuta, indicate that Amakama is negatively 

correlated to the other two environments. The acute angle between Abeokuta and Bauchi reiterates the 

summary statistics result, that phenotypic responses at these two locations are correlated. 
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GGE Biplot 
The GGE (genotype main effect (G) plus genotype-by-environment (GE) interaction) biplot is a modification of 

the AMMI model, which joins the effects of the genotypic main effects and the genotype-by-environment 

interaction (Yan & Kang, 2003). As this describes both the genotypic main effects and genotype-by-

environment interaction together, it is known as a GGE model, and the biplots are called GGE biplots. The 

interpretation of the GGE biplot is similar to the AMMI biplot, but now the genotypes are distributed according 

to overall performance in each environment, rather than just genotype-by-environment interaction. In the GGE 

biplot, the best performing genotypes are on the right-hand side of the plot.   

 

 
Default GGE Biplot options 

Variance-Covariance Modeling 
Variance-covariance modeling is a mixed model approach to examination of genotype-by-environment 

interactions in terms of heterogeneity of variances and covariances. Breeding View evaluates a range of 

possible variance-covariance models and selects the best based on an information criterion. 
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Stability coefficient measures for the genotypes: 
Cultivar-Superiority Measure (Lin & Binns, 1988): The sum of the squares of the difference between genotypic 

mean in each environment and the mean of the best genotype, divided by twice the number of environments. 

Genotypes with the smallest values of the superiority tend to be more stable, and closer to the best genotype 

in each environment. 

Static Stability Coefficient is defined as the variance between its mean in the various environments. This 

provides a measure of the consistency of the genotype, without accounting  performance 

Wrickes Ecovalence Stability Coefficient (Wricke, 1962): The contribution of each genotype to the genotype-

by-environment sum of squares, in an un-weighted analysis of the genotype-by-environment means. A low 

value indicates that the genotype responds in a consistent manner to changes in environment. 

 
The most stable genotype identified by the Cultivar-Superiority Measure is IT 89-KD-245. 

 

When Breeding View is run, the data files are automatically saved to your computer in the Workspace folder. 
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Multi-Site Multi-Year Analysis 

Introduction 
The Breeding Management System (BMS) does not yet have the capability to preform multi-site multi-year 

statistical analysis. Expect this functionality in future versions.  However, the BMS does support the export of 

multi-location trial data, including multiple years, as a merged single data file. The observation sheet of this 

merged data file contains all of the factors needed to support analysis of trial data by external statistical 

packages, such as R. 

Select Multi-Year Multi-Site Analysis from the workbench menu. Browse for a dataset of interest.

 

Select Datasets of Interest 
Select the raw data (PLOTDATA) for a trial or the means data (MEANS) created from the single site analysis 

to include in the export file. 

 

Review the data from a single trial and Save to List. 

 

Multiple locations within the selected trial will display in the review window. 
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Select additional trial datasets. 

 

Review the content of selected datasets and click Next. 

 

Specify Data to Export 
Select environments, traits, and factors of interest to export. 
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The default name for the export file is mergedDataSets.xls. Choose a location for the export file and select 

save.  The merged file contains combined data from all selected trials. 

 

QTL Analysis: Cowpea Tutorial 

Contributors 

Darren Murray 
a
, Roger Payne 

a
 & Zhengzheng Zhang 

a
, Shawn Yarnes 

b 

a
 VSN International Ltd, 

b 
The Integrated Breeding Platform 

Summary 
Use the standalone Breeding View application to correlate population genotypic variance and population 

phenotypic variance to identify quantitative trait loci (QTL). Visualize QTL, map, and genotypes using 

Flapjack. 

 Introduction 

 QTL demonstration Data 

 Start New QTL Project 

 Import Data Files 

 Run Analysis 

 Analysis Options 

 Results 

 Visualize QTL in Flapjack 

 References 

Introduction 
Breeding View uses a combination of simple interval mapping (SIM) and composite interval mapping (CIM) to 

test for significant correlations at each of the marker positions as well as between markers. The SIM method 

is followed by CIM to increase the power of the genome-wide QTL search. CIM includes candidate QTL 

identified by SIM as cofactors in the QTL scan model to control for variation caused by QTL outside the test 

region. 
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QTL Demonstration Data 
Cowpea (Vigna unguiculata) genotypic and phenotypic data are from a population (N=111) of 109 F2 

individuals and 2 parental lines, Suvita-2 and IT 97K-499-35. The F2 population has been genotyped with 164 

markers. The map file contains 159 of the 164 markers mapped to 11 linkage groups. 

 
Genotypic relationships in cowpea QTL demonstration data 

Three data files are needed to perform a QTL analysis: 

 Map file 

 Genotype file 

 Phenotype file 

The map file specifies the marker locations by linkage group and position (cM) within linkage group. The 

genotype file contains the marker scores of each individual in the population. The map and genotype files are 

plain text files in Flapjack format. The phenotype data file contains the observations of one or more traits of 

each individual in the population. 

Start New QTL Project 
The standalone Breeding View application can be launched from the left hand Workbench menu. 

 

Alternatively, Breeding View can be launched independently of the Workbench by accessing the application 

within the Tools folder > Breeding_View. 

 

When Breeding is launched, the Project window and Analysis Pipeline will not contain any information. 
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Create a new project, by selecting File > New Project from the menu bar, or click on the New Project tool 

button. In the New Project dialog, select the QTL linkage analysis item within the Project type list. Enter 

project details.  The current version only supports single site analysis, so select Single for the Environment 

and choose the appropriate Population description from list. Select F2 population. Name the project and 

select the location of the working directory. Click OK to create the project. 

 

When a project has been created, the Analysis Pipeline is displayed along with project details on the left. The 

Analysis Pipeline includes nodes, which are connected by arrows. Each node represents a different task that 

is performed within the QTL analysis pipeline. 

 

Import Data Files 
The genotypic and phenotypic data need to be imported into the project before the analysis pipeline can be 

run. To import the genotypic data, select Project > Add Data from the menu, or click on the Add to Project tool 

button. On the Add to Project dialog, click on the Genotypic and Map Data button. 

 

BMS File Directory 

C:\Breeding Management System\Documents\Breeding View\Sample Files\data1\Cowpea_genotypes.txt  

C:\Breeding Management System\Documents\Breeding View\Sample Files\data1\Cowpea_map.txt  

C:\Breeding Management System\Documents\Breeding View\Sample Files\data1\Burkina_trait_means_for_qtl

_analysis.txt 
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In the Open Marker and Map Data dialog, select the Flapjack formatted genotype and map .txt files. Browse 

for files by clicking on the [...] button. Click Open to import the data. 

 

Breeding View will only import information on markers common to genotype and map files. Select OK. 

 

Import the phenotypic data file by selecting Phenotypic Trait Means from the Add to Project menu. 

Import all three traits, and choose Genotypes as the genotype factor. Click OK to import the data. 

 

After the data have been imported, the selected traits appear within Project tab on the left side of the screen. 

Set Seed Weight as the active trait by right-clicking SEEDWT_Means and selecting Set As Active Trait. The 

green check mark indicates that it is the trait that will be used within the analysis pipeline. 
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Run Analysis 
To run the QTL analysis pipeline, click on the right-mouse button on the first node, Quality Control 

Phenotypes, and select Run Pipeline. This will run the whole analysis pipeline, by performing the task at each 

node in turn. As the task at each node is completed, the connecting arrow will change color, to indicate that 

the pipeline is moving onto the next task. 

 

Analysis Options 
Some of the nodes have options to control they way an analysis is performed and output that is displayed. To 

access the options, right-click on a node and select the Settings item from the shortcut menu. The changes to 

the options are retained during the current session and are saved to the project file. 

Summary Statistics 
Settings under Quality Control Phenotypes define the phenotypic summary statistics that are displayed in the 

output. 
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Quality Control Marker Data 
Settings under Quality Control Marker Data define the display, summary statistics, and missing value 

thresholds for marker data. 

 

QTL Scan Options 

Settings under QTL Scan Options define the QTL scanning conditions. By default Breeding View performs a 

single SIM followed by two rounds of CIM scanning. The number of CIM scans can be increased until the list 

of detected QTLs does not change. In CIM scanning, to avoid co-linearity between cofactors and tested 

positions, cofactors are removed temporarily from the model when testing for QTLs close to cofactor 

positions. The window within which cofactors are removed is set by default to 50 cM.  

 

Leave the default settings for this tutorial and run the entire analysis pipeline by right clicking the first node 

and selecting Run the Pipeline. When the analysis completes, a prompt will appear to indicate it has finished. 
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Restart Analysis 
After a pipeline has been run, you can change settings and start again from any point along the pipeline. 

Results 
The output tab contains the summary statistics for seed weight means, marker data, and detected QTL. 

 

 
Summary statistics seed weight Cowpea QTL  

 
Summary statistics marker data Cowpea QTL 
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The summary for the marker data, displayed in the Output tab, provides details of the numbers of markers 

within each linkage groups and the number of missing observations.  

There are no markers with 50% or more missing observations. However, there is one genotype, UCR201005-

1B-40, reported that contains greater than 50% missing observations, so this has been removed from the QTL 

detection. 

Output is produced for each round of SIM and CIM, with a summary of the loci greater than the detection 

threshold and candidate QTL. 

After the last round of CIM, the effects of significant QTL are estimated. 

 
Two QTL associated with seed weight identified on chromosomes 6 and 8 explain 11.9 and 17.2% of the 

variance in seed weight respectively. 
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The QTL detection produces graphs of the scan profiles for the simple interval mapping and each round of 

composite interval mapping. Each graph displays the profile within each linkage group, the threshold of 

detection, and parent contributor of the high value allele. All figures are saved as image (.png) files within the 

working project folder, in a subfolder using the date and time. The phenotypic identifier will begin the file 

name. 

 
Seed weight QTL profiles for SIM and two rounds of CIM   

A figure where QTL are overlayed on the genetic map is automatically saved an image (.png) file to the 

working directory when the pipeline is run. 

 
SEEDWT_Means_Report_GeneticMap001.png from the cowpea QTL demonstration data 

Report 
The final results are collated and displayed in the Report tab within an HTML document. The HTML report 

(Report.htm) is automatically saved within the working project folder, in a subfolder using the date and time. 
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The seed weight report and genetic map graphs are automatically named from the column heading in the 

phenotype file (SEEDWT_Means_Report.htm and SEEDWT_Means_Report_GeneticMap001.png). 

 

Visualize QTL in Flapjack 
When the QTL analysis pipeline is complete, Flapjack (Milne et al., 2010) automatically opens a graphical 

genotype display. The Flapjack project file is saved in a file within the working project folder in a subfolder 

using the date and time of the run. The file is automatically named SEEDWT_Means.flapjack. You may be 

asked to update your version of Flapjack before proceeding. 

Overlay QTL on the genotypic display by selecting Filter QTLs from the Data menu. 

 

Select the trait(s) of interest and the relevant experiment. 
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QTL are now visible on their respective chromosomes. 

 
QTL associated with seed weight on chromosome 6 at 11.45 cM 

 
QTL associated with seed weight on chromosome 8 at 26.75 cM 
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Marker-Assisted Breeding 

Molecular Breeding Planner 
The Molecular Breeding Planner facilitates planning for population development, selections, and crosses 

using molecular marker data.  Marker-assisted selection (MAS) can speed the breeding process by increasing 

the frequency of favourable alleles and decreasing the frequency of unfavourable alleles in breeding 

populations.  The Molecular Breeding Planner helps breeders develop breeding schemes, including timelines 

and optimal population sizes, to improve the efficiency of genetic gains using genetic markers. 

Planning tools support 

 Marker-Assisted Recurrent Selection (MARS) 

 Marker-Assisted Backcross (MABC) 

 Marker-Assisted Gene Pyramiding 

Launch 
The Molecular Breeding Breeding Planner is a standalone application that can be launched from the 

Workbench menu. 

 

Alternatively, the Molecular Breeding Planner can be launched independently of the Workbench by accessing 

the application within the Tools folder. 

Interface 
The interface contains the following windows, which will be empty until you establish a project: 

 Project Window: Lists all molecular breeding programs within an open project- three distinct programs 

can be considered: MARS, MABC and MAS for gene pyramiding. 

 Parameter Setting/Viewing Window: You can edit/view your breeding parameters in this window. 

 Breeding Scheme Window: Once the breeding parameters are specified, a breeding flowchart will be 

demonstrated in this window. 

 Plan-Making Window: You can select the current stage/generation of your breeding programs in this 

window to formulate a detailed plan for the near future. 
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Create a New Project 
Select New Project from the Project dropdown menu. Give your project file a name and select a destination 

folder for the output. Multiple breeding plans can be saved within a single project file. 

 

From the task menu, select one of the new breeding plans: 

 MARS: Marker-Assisted Recurrent Selection 

 MABC: Marker-Assisted Backcross Breeding 

 MAS: Marker-Assisted Selection for Gene Pyramiding 

 

Add details of the breeding plan to the Input Information screen. Users can import the parameters from an 

external file (file extensions .mars, .mabc, or .mas) or set the parameters by hand. 
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About Expected Seeds Per Plant 

 Expected Seeds Per Plant is set to a crop specific default.  The user can modify this number, but the 

input must fall into the min-max range for the selected crop. If input number is smaller than the 

minimum number, the minimum number will be assumed. If the input number is greater than the 

maximum number, the maximum number will be assumed.  

 Expected seeds per plant is used to determine seed availability for phenotyping. If seed inventory is 

too low , additional seed increase by selfing will be requested. 

 The number of seeds required for phenotyping is calculated from settings for Multi-Locational 

Phenotyping. For example, multi-locational phenotyping is only possible when there are enough F2 

plants to produce the expected amount of seed. Otherwise, phenotyping will be delayed until the 

required seeds are produced. 

Select Finish to populate the parameters and breeding scheme. 

 

Make a Breeding Plan 
Once the parameters are set, right click the breeding method folder, and select Make a Plan from the 

dropdown menu. 
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Marker-Assisted Recurrent Selection (MARS) Plan 
The marker-assisted recurrent selection (MARS) planning tool schedules events, models QTL to include as 

selection criteria, proposes selections, plans crosses, and predicts homozygosity in fixed line development. 

 
Diagram of a MARS breeding program in cowpea, a self-pollinated species 

MARS consists of four main stages: 

 Training population development: A training population is evaluated for phenotype in field trials 

and genotyped using mapped genetic markers.  The MARS planning tool will assist in scheduling 

training population events to meet anticipated deadlines. 

 QTL analysis and selection: QTL analysis correlates phenotypic variance to genotypic variance, and 

identifies putative genetic regions involved in quantitative traits. The MARS planning tool will schedule 

QTL analysis and model a selection of QTL that optimize the traits of interest for recombination. 

QTL analyses can be performed with the Breeding Management Systems Breeding View statistical 

software (see section 5.8) or with other external software applications. 

 Recombination: After QTL are identified another Breeding Management Tool, OptiMAS, can be used 

to identify progeny from the training population for inter-mating. The MARS Planning Tool develops a 

plan for crossing progeny selected using OptiMAS. 

 Fixed line development: The MARS Planning Tool will propose optimum selection scheme for each 

generation of selfing and predict the homozygosity of the breeding population. 
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Choose start date and the set the current status of the breeding program. Select the Make a Plan button. 

 

The breeding documentation window will appear with a timeline for the project accessible as a .txt file in the 

project folder.  

 

Marker-Assisted Backcross Breeding (MABC) Plan 
Choose start date and the current status of the breeding program. Select the Make a Plan button. 
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The breeding documentation window will appear with a timeline for the project accessible as a .txt file in the 

project folder.  

 

Marker-Assisted Selection (MAS) for Gene Pyramiding Plan  
Selection for two or more genes at a time, or gene pyramiding, can be greatly enhanced by marker-assisted 

section (MAS).  Gene pyramiding requires a complex design strategy that outlines the number of markers 

required, best crossing strategies, and the level of inbreeding to maximize the efficiency of marker 

implementation. The Molecular Breeding Planner does a simulation analysis to develop breeding plans for 

gene pyramiding.  

 
Nine major genes and their distribution in three wheat parental lines 

 
Optimum crossing and selection scheme for gene pyramiding identified by simulation 

Save a Project 
When the Molecular Breeding Planner is closed, projects are automatically are saved as .ibp files. A folder 

titled with your project name will appear in the destination folder you established when you created the 

project. This project folder will automatically be populated with the .ibp project file and subfolders relating to 

different marker-assisted breeding plans. 

Individual breeding plan files that are displayed in the Project window can also be saved independently of the 

project folder by right clicking and selecting the Save As option. 
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Open Existing Project 
From Open in the Project dropdown menu, you can browse for existing .ibp project files. 

Alternatively, from New Project in the Project dropdown menu, you can search for existing projects if you 

know the name and can specify the root directory. 

Molecular Breeding Design Tool for Backcrossing 
The Molecular Breeding Design Tool can be used in backcross breeding applications to design ideotypes 

based on QTL target regions (foreground markers) and to recover recurrent parent genome (background 

markers). The graphical display facilitates the comparison of germplasm based on genotype. 

 

Graphical display assists with: 

 The selection of donor and recurrent parents 

 Assign foreground markers associated with QTL 

 Assign background markers to recover recurrent parent genome 

 Design a target genotype (ideotype) 

Additional tools to: 

 Determine the minimum number of individuals that need to be genotyped in each BC generation to 

recover at least one double homozygote for the markers flanking target QTL at the end of the program 

 Identify polymorphic makers between any two accessions 

Acknowledgement 
The Molecular Breeding Design tool was developed by Trushar Shaw, International Crops Research Institute 

for the Semi-Arid Tropics (ICRISAT) Patancheru, India with funding from the Integrated Breeding Platform. 

Launch 
The Molecular Breeding Design Tool (MBDT) is a standalone application that can be launched from the left 

hand Workbench menu. 
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Alternatively, the Molecular Breeding Design Tool can be launched independently of the Workbench by 

accessing the application within the Tools folder. 

BMS File Directory 

C:\Breeding Management System\Tools\MBDT 

 

Navigating the Workbench 
The application opens with the MBDT workbench, where you can create and manage your projects.  

 
Default workbench view 

Clicking the button in the bottom left of the window displays the other tab options. 
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Selecting ‘Other’ allows for additional windows to be selected and opened by selecting OK. 

 

Double clicking any tab brings the window to full screen. The windows on the workbench can be dragged and 

dropped to customize the workbench. 

Left: Linkage Map Data View is 

opened in the workbench at the starting position of the workbench. Right: Linkage Map Data View 

repositioned in right corner of the workbench 

Input Files 
MBDT input files include tab delimited text files: 

 Genotype data in GCP genotyping data template, 

 Linkage Map data in CMTV readable file format, 

 QTL information from iMAS 

 Phenotype Data 

BMS File Directory 

C:\Breeding Management System\Documents\MBDT\Input\ Files\Sample Data 
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Genotype File 
Prepare the genotype data file as a .txt file.  When saving in Microsoft Excel select the Tabs Delimited Text 

option. The DatasetID column identifies the dataset. The Genotype/Marker identifies the lines or accessions. 

Subsequent columns contain the marker data . 

 

Prepare advanced generation genotype data as follows: 

 

Linkage Map File 
Prepare the Genotype data file as a .txt file.  When saving in Microsoft Excel select the Tabs Delimited Text 

option. The DatasetID column identifies the dataset. The Genotype/Marker identifies the lines or accessions. 

Subsequent columns contain the marker data. 

 

QTL File 

Prepare the QTL file as a .txt file with the following column headings: 

 Name: QTLID 

 Chromosome: Chromosome ID 

 Position: QTL position with highest LOD score (cM) 

 Pos-min: Start position of the QTL (cM) 

 Pos-max: End position of the QTL 

 Trait: Trait ID 

 Experiment: Environment ID 

 CLEN: Chromosome length (cM) 

 LFM: Left flanking QTLmarker 

 PLFM: Position of left flanking QTLmarker 

 RFM: Right flanking QTLmarker 

 PRFM: Position of right flanking QTLmarker 

 Effect 

 LOD 

 R2 
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Phenotype File 
Prepare the phenotype file as a .txt file with the first column heading, Genotype, identifying lines or 

accessions, followed by columns of trait measurements. 

 

 

Create New Project 
Select New Project action from the File menu to load data. 

 

Browse the input files: genotype, linkage map, QTL, phenotype. Genotype and linkage map file are 

mandatory. Once you browse the files, the system validates the input files and prompts the summary, which 

includes marker type, number of genotype, markers, traits, and QTLs.  The warning log will display 

information about missing data, duplicated markers and other relevant warnings. 
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Click Finish to upload files to the workbench and observe that Graphical View overlays QTL onto the Linkage 

Map. 

 
E1, E2, E3 indicates that phenotypic data was collected from three environments. 

Save Project 
Select File>Save. Enter and project name and generation. Click OK. The project will be saved as a .ser file 

within a MBDT_PROJECTS files folder. 

 

Open Project 
Select File>Open. Select the project name and generation. Click OK to load the project. 
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Accession List & Selected Accession View 
Select accessions of interest as probable donor or recurrent parents. Use Ctrl/ Shift Key for multiple 

selections. 

 

These selections will now appear in the Selected Accessions View. Selections are by default set to Recurrent. 

Change the default by choosing Donor from the drop down menu. 

 

Sort individuals based on the frequency of alleles for the selected marker. Select marker of interest and click 

on, or right click on Graphical view. Select Sort. 
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Alternatively, go to the Windows menu option and select Sorting Markers.  Choose chromosome and marker, 

and click Sort. 

 

Sorting displays accession list with rare alleles at top and more common alleles at bottom. 

 
Selected accessions sorted by first marker, umc164c, on chromosome 1 

Hide Accessions 
Hide the heat maps of selected accessions in Graphical View. Select the appropriate heat maps. Right click 

on selections and click Hide. 

 

Reveal Hidden Accessions 
Right click on selection and click Show Hidden Elements. Choose the hidden accessions that you would like 

to reveal and click Finish. 
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Graphical View 
Select Refresh to update changes made in the Selected Accession View. Heat maps of selected accessions 

display genotype information as coloured boxes allowing comparison of genotypes with linkage and QTL map. 

 

The accessions are now visible from the graphical view. 

 
R and D represent recurrent and donor parent assignment. Colored boxed on the grey bar represent the 

screened marker for which genotype data is available. The markers are coloured based on the allele values. 

The missing values are coloured in background colour, light grey to represent un-genotyped sections of the 

chromosome. 

Click on QTL region to view QTL information in pop-up window. 
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Similarity Matrix 
Select Similarity to generate a similarity matrix to visualize the percentage of similarity between selected 

parents based on the number of shared alleles. 

 

Unscreened Markers 
Select an area of linkage map to populate the Unscreened Marker view. 

 

The unscreened markers display as a list. 
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Missing Markers 
View the missing markers for each accession. 

 

Lims Markers 
Identify genotyped markers that match markers within the linkage map. Select Lims Input menu > Lims 

Markers. Select OK. 

 

Delete markers from the list by right clicking selections and choosing Delete Selected Marker. Select Export > 

Lims Markers to save this list as a .txt file. 
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Lims Subset 
Select Lims Input > Lims Accessions. The Lims Subset View allows export of the genotype list as well as a file 

outlining 96 or 384 well PCR plates. 

 

Linkage Map Information 
View information about the linkage map by selecting this view. 

 

View Phenotypic Data 
Sort phenotypic data by double clicking the trait name. 
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Chromosome View 
Limit graphical view to a single chromosome by selecting Chromosome View and choosing a chromosome of 

interest. 

 

 

Customize Marker Colors 
Change the default colors by select Preferences under the Windows menu. Change the color of any allele 

using the color editor. 
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Assign Foreground & Background Markers 
Foreground Markers are the markers linked to QTL from the donor parent. Background markers are unique to 

the recurrent parent and are used to track the recovery of the recurrent parent genome. By default all markers 

are defined as background markers. 

Assign markers as Foreground markers by selecting a QTL on the QTL map or a portion of the linkage map. 

Right click and choose Assign Marker as > Foreground. 

 

Assigning a foreground marker will result in a broadening the representative rectangular boxes. The status of 

marker in the LinkageMap data view will be changed accordingly. 

Revert foreground markers to background markers by selecting the QTL or a portion of the linkage map. Right 

click and choose Assign Marker as > Background. The status of marker in the LinkageMap data view 

will change accordingly. 

Find Polymorphic Markers 
Compare potential parents based on their polymorphic markers by selecting two accessions and right clicking 

to selecting Compare from the drop down menu. 

 

The graphical field will narrow to the two selected accessions. 
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Select both accessions.  Right click to choose polymorphic markers from a list. 

 

Create Target Genotype 
Select the donor and recurrent parents in graphical view. Select the Target Genotype button from Target 

Genotype View. The target genotype illustrates polymorphic markers between donor and recurrent parent. 

Markers in the target genotype represent the recurrent parent. 

 
D donor parent (IS86818) and R recurrent parent (IS8685). The T target represents the markers that differ 

between the parents 

Replace recurrent parent marker alleles with the desired forward markers from the donor parent. Select the 

donor parent marker and drag and drop to the target marker location. 

  

Chromosome 3: Donor parent marker (top) dropped on the target genotype (bottom) 

Save the movements of markers while preparing Target Genotype by clicking on drop down arrow and 

choosing Action and then History of movements. A click on History of movements will open a Save As File 

Dialog to save the list of moved markers into text file with *.txt file. 

  



 122 

Determine Population Size for Next Generation 
Determine the minimum number of individuals that must be genotyped in successive backcross 

generations.  The PopMIN tool estimates the population size required to obtain at least one double 

homozygote for the two markers flanking target QTL. Select PopMIN, enter the appropriate values and click 

OK. 

 

PopMIN results are displayed in the terminal. 

 

Advanced Generations 
As subsequent generations are genotyped they can also be viewed with Molecular Breeding Design Tool. 

Select File > Load Target Data. Select the project and the previous generation from the drop down menu. 

Load the current generations genotype data, and click Finish.  
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The second generations genotype is graphically displayed beneath the previously established target 

genotype. 

 

Percentage Recovery 
Select Percentage of Recovery to view the proportion of recurrent parent markers in the second generation 

accessions. 
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Select Best Individuals 
Select Accessions of interest and right click to select the Best Individuals.  Choose the foreground marker(s) 

to base the selection. Include missing information by selecting Missing. Click Finish. 

 

The best individuals are highlighted in the Access List View. 
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Summary 
Use OptiMAS to select and cross the best of 297 genotyped individuals for the next round of marker-assisted 

recurrent selection (MARS). Calculate the predicted genetic value of genotyped individuals based on 11 target 

QTL. Design crosses based on the likelihood of combining all favorable alleles into a single individual. 

 Introduction 

 Demonstration Data 

 Run OptiMAS 

 Prediction 

 Selection 

 Intermating 

Introduction 
OptiMAS (Blanc et al. 2013) predicts crossing strategies that optimize the likelihood of assembling favourable 

alleles into a target genotype. Molecular markers in the vicinity of favourable parental QTL are used to trace 

the movement of QTL between generations. OptiMAS uses genotype data to predict the probability of allele 

transmission in different marker-assisted selection (MAS) schemes and mating designs (intercrossing, selfing, 

backcrossing, double haploids, RIL), allowing some generations to be considered without the need to 

genotype. Selection and crossing strategies are based on expected progeny genotypes. OptiMAS supports 

decision-making associated with the marker-assisted breeding plan generated by the Molecular Breeding 

Planner. 

OptiMAS is a Breeding Management System standalone tool that can be launched from the workbench or 

from a desktop icon. OptiMAS has a graphical user interface, but can also operate from command line. For 

more information on command line operation and additional demonstration examples see the OptiMAS 

development site or read the full manual (pdf).  
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Demonstration Data 
The maize (Zea mays) data set comes from a mulitparental population described by Blanc et al. 

2006 and 2008. Eleven QTL were detected for silking date based on six connected F2 populations, based on 

150 individuals each. The F2 populations were obtained from a half-diallel design between four unrelated 

maize inbred lines (DE, F283, F810 and F9005). A set of 34 markers was selected with at least three 

microsatellite markers following each QTL. Two cycles of marker-assisted recurrent selection (MARS) were 

performed with a step of selfing occuring before each intermating. In this example, OptiMAS is used at the last 

cycle to select the best individuals among 397 genotyped plants for the next cycle of MARS. 

 
MARS Breeding Scheme (Reprinted with permission from Blanc et al. 2006, 2008) 

Genetic Map File (.map) 

The map file is supplied by the user and specifies QTL of interest, flanking makers, and favourable alleles. 

QTL identified by the Breeding Management Systems Breeding View application, and other external 

applications, can be used to create the genetic map file for OptiMAS.   

BMS File Directory 

C:Breeding Managment System\Tools\OptiMAS\input\blanc.map  

 
5 of the 11 QTL and flanking markers described by their map position (pos) in cM 
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Map File Columns 

 Locus: Mame of markers and QTL. QTL name are prefaced with "qtl".  

 Chr: Chromosome  

 QTL: QTL numbered in ascending order  

 Pos: (cM) For QTL, this is the estimated QTL position coming from the QTL detection results. 

Positions of the different loci must be obtained using the Haldanes mapping function (i.e. by assuming 

no interference). 

 All+: Parental allele considered favourable for the QTL 

Genotype/Pedigrees File (.dat) 

The genotype/pedigree file is in plain-text tab-delimited format (no space between fields). Column headings A-

F should not be changed even if the 2 optional columns, Cycle and Group, are left blank (or -). Column 

headings begining with G describe the 34 microsatalite markers. This format is very close to the input format 

of the Flapjack software. 

BMS File Directory 

C:Breeding Managment System\Tools\OptiMAS\input\blanc.dat  

 
15 of the 279 genotyped lines: The first four rows are inbreed parental lines (IL) homozygous for all 34 

markers. Rows 6-8 are heterozygous F1s, and are not genotyped. Rows 9-15 are genotyped F2 individuals. 

Markers are numerically coded; A=1, C=2, G=3, T=4. 

Genotype/pedigree file column descriptions 

 Id: The name of each genotyped individual. Individual IDs must unique and ranked according to 

generations (from oldest to most recent). The first individuals of this file must correspond to the 

founder parents of the program (here D,F,S, & X) that are assumed to be homozygous lines. 

 P1 & P2: Correspond to the name(s) of the parent(s) of the individual (must exist as individuals in 

above in the file). The pedigree of the parental lines is assumed to be unknown. For a founder line P1 

and P2 columns indicate the name given to the allele (e.g. A, B or any other character) coming from 

this line that will be traced through generations. 

 Step: Corresponds to the pedigree relationship between the individual and its parent(s): 

 CR: Cross indicates that the individual results from a cross between its two parents. 

 Sn: Selfing indicates that the individual results from n generations of selfing of its parent (in this case 

the two parent Ids must be identical). 

 RIL: Recombinant inbred lines, assumes that the individual results from an infinite number of selfing 

generations from an initial F1 hybrid. In this case, parent 1 and parent 2 must be identical and 

correspond to the F1 hybrid. 

 DH: Double haploids assumes that the individual results from haplo-diploidisation from an initial F1 

hybrid 

 IL: Inbreed line indicates founder inbred status 

 Cycle: Optional information regarding the generation in the program (e.g. F2, F4, C1, etc.). 

 Group: Optional information regarding another classification criterion (e.g. subprograms, families, 

etc.). 
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 Mk1-Mkn: These are the genotyping results. The software can deal with SNPs, microsatellites, and 

any bi/multi allelic marker genotyping technique with either dominant or codominant scoring. The 

markers present in the genotypes/pedigree file must be ordered and match those in the map file 

(same number of markers). Homozygous genotypes for an allele (e.g. A) can be scored either as A or 

A/A. Heterozygotes are expected to be separated by a / (e.g. A/G). Heterozygous genotypes are 

assumed to be unphased (i.e. A/B equivalent to B/A). Missing data at marker loci are allowed and 

must be entered as - (or can be left blank and corrected later  see below). For dominant markers, 

assuming A dominant vs. a recessive, genotypes presenting allele A must be coded A/-. Parental 

inbred lines should not contain missing data. Given the possibility to include non-genotyped 

individuals, this makes it possible to analyse most common marker-assisted selection schemes and 

mating designs. 

Run OptiMAS 
Launch OptiMAS from the workbench or from the OptiMAS executable file located in the Tools folder. 

 

Select File > Import Data from the menu bar and browse for the genetic map file (.map) and 

genotypes/pedigree file (.dat) Set the location of the output directory. Results from each run will be stored 

within a new dated directory created automatically within this folder. Note that your output directory should not 

be in the Program Files folder or other specific directories with administrator privileges. Select Run button to 

analyse the data set. Close the Import Data window when the progress bar displays 100%.  
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Advanced options/parameters 

 QTL Analysed: By default all the QTL present in the input files will be analysed. You can also choose 

to select a specific QTL to run the analysis. 

 Cut-off -Diplotypes: Genotypic probability below which a rare phased genotype (diplotype) is removed 

and not considered in subsequent computations (default value = 0.000001), to reduce memory and 

time needed for computation 

 Cut-off-Gametes: Gametic probability (default value = 0.000000) that corresponds to the probability 

that the number of crossovers expected in the region between flanking markers exceeds a given 

value. Thus, unlikely haplotypes, or gametes, with number of crossovers over this value are removed 

and not considered in subsequent computations. Use of this option with values up to 0.01 is 

recommended in case many flanking markers per QTL lead to high computation time with default 

option. 

 Verbose: Verbose mode creates two files per QTL position, reporting respectively gamete and 

diplotype probabilities for all individuals (default value = ON). 

Correct Missing Genotype Data 
A .cmap file has been created for import into the FillMD@Mks tool, which will fill in missing data with a 

placeholder and reconfigure the genotype/pedigree (.dat) file for reanalysis. A genotype/pedigree file may 

contain missing data due to genotyping errors.  If a warning message appears after running OptiMAS, missing 

data may need to be replaced with a placeholder (-). Load input (.cmap and .dat) and set output directory, the 

path to the folder where the results will be stored. The .cmap file created at the end of a previous run of 

OptiMAS is used to re-run OptiMAS marker by marker and localize genotyping errors at individual marker 

position. The (.dat) file is the same genotype pedigree file used to run OptiMAS the first time. The output 

directory sets the destination of a new genotype/pedigree file (.dat) missing data is filled with a placeholder (-

).  

 

Note: It is also possible to directly display the results of previous analyses by selecting File > Reload data. 

You can also display results from the two examples data sets provided with the program, that are located in 

File > Example Data > Multiparental from the menu bar. 

Prediction 
Each QTL is given a score based on its probability of transmitting favourable alleles to gametic genotypes, or 

haplotypes. Genotyping data is phase ambiguous when markers are heterozygous, so OptiMAS calculates all 

possible phased diplotypes along with their probabilities, and then determines all of the possible gametes 

(haplotypes) and their probabilities at each QTL. OptiMAS summarizes the predicted genetic value of 

genotyped individuals into several metrics that inform selection. 
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Access Prediction Functions by clicking Step 1 from the left menu. 

 

Molecular Score Prediction Table 
Genetic values and QTL scores are summarized in the Molecular Score (MS) Prediction window. Data can be 

sorted by MS or other criterion by double clicking the column heading. 

 
Molecular score prediction table sorted in ascending order by MS 

Column Descriptions 

 The first five columns correspond to the first five columns of the genotype/pedigree (.dat) file (see 

Genotype/Pedigree File Structure  section 7.5.1) 

 MS: Molecular Score is the additive probability of transmitting favourable alleles over all QTL. MS 

varies between 0, for an individual who does not carry any of the favourable alleles, to 1, for an 

individual which is homozygote for the favourable alleles.  Individuals with a MS of 1 correspond 

perfectly to the target genotype. 

 Weight:  Breeder designated scaling of QTL importance in the breeding scheme (see QTL Weights  

section 7.7.5) 

 UC: The utility criterion (UC) combines molecular score of an individual with the expected variance of 

gametic molecular scores possible from that individual. UC is based on the estimation of the expected 

number of favourable alleles carried by the superior 5% gametes produced by the individual. This 

criterion favours individuals with no fixed unfavourable alleles. This score ranges from 0 to the 

number of QTL. Note that present version of UC estimation assumes independence between QTL 

and should be considered as only indicative in the case of linked QTL. UC also assumes that the 

distribution of scores can be approximated by a normal distribution, which is not a valid assumption in 

case of small number of heterozygous QTL. 

 No.(+/+): Number of QTL homozygous for favourable allele(s). A given QTL is considered 

homozygous for favourable allele(s) when the probability (+/+) exceeds a default threshold value of 

0.75 (see Change Default  p. 151). 

 No.(-/-): Number of QTL homozygous for unfavourable allele(s). A given QTL is considered as 

homozygous for unfavourable allele(s) when prob (-/-) exceeds a default threshold value of 0.75 (See 

Change Default). 

 No.(+/-): Number of QTL heterozygous with both favourable and unfavourable allele(s). A given QTL 

is considered to belong to this category when prob (+/-) exceeds a default threshold value of 0.75 

(See Change Default). 
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 No.(): Number of QTL defined as uncertain. Concerns QTL which are not attributed to any of the three 

previous categories. 

 QTL: Individual molecular scores corresponding to each QTL 

Molecular Score Details 
More detailed genotypes can be displayed by double clicking on MS or QTL cells. This view summarizes and 

aggregates the information presented in the Homo/Hetero and Estimation of Parental Allele Probabilities 

tables.  Double clicking the cell representing QTL 2 of individual B8 to reveal a yellow popup box. 

 
B8 has a molecular score of 0.8366451 at QTL 2, which has a probability of 0.734596 to be homozygous for 

the favourable allele f (i.e. Homo(+/+)). This score corresponds to the sum of the probabilities of the 

genotypes f:f=0.734596, f:s=0.234358 and d:f=0.0167074. QTL 2s MS of 0.995832 corresponds to the 

expected proportion of favourable allele(s) (i.e. Homo(+/+) + Hetero(+/)). Founders, represented by the d,f,s, 

and x  alleles, indicate the expected proportion of parental alleles. 

Visualize Genotypes 
The Visualization of Genotypes window creates a custom color-coded view of the molecular score table to 

more easily identify fixed QTL. The default value of 0.750 for cut-off colours can be altered from this window. 

When you apply a new set cut-off/colour parameters, the four corresponding columns [No.(+/+), No.(-/-), 

No(+/-), No.()] on the MS table are updated. Uncertain genotypes can be due to (1) recombination near the 

QTL position making one flanking marker heterozygous and the other being homozygous favourable or (2) 

due to missing data in the genotypes/pedigree (.dat) file. 
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Graphical Output 
Select graphs to visualize the tabular information. All the graphs can be exported as .png, .svg or .eps formats 

by selecting Save. 

 
The left graph illustrates the frequency of favourable alleles at the different generations of selection. Note that 

no genetic gain is expected for the last generation (C2, in blue), because individuals have not yet been 

selected. The right graph is a histogram of the number of individuals with different molecular scores (MS) for 

QTL1 . 

QTL Weights 
The favorable allele at QTL 1 is in danger of being lost, because the 11 best individuals as defined by overall 

molecular score (MS) are fixed at 0 for this QTL. 

 
Top 12 germplasm based on molecular score (MS): Not weighted for QTL 1 
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OptiMAS attributes the same weight to all QTL in the map file for molecular score (MS) estimation.  However 

is possible to discard QTL and/or to attribute weights defined by the breeder by applying a Weight index to the 

MS calculation. Select the Weight button to open the QTL Weights dialog window. Assign QTL 1 a weight of 3 

to produce a new classification of individual based on the new weighted MS. 

 

Increasing the weight of QTL 1 allows germplasm to be sorted by weighted molecular score, and ensures that 

some of the top scoring germplasm can transmit the favorable allele. 

 
Top 12 germplasm based on weighed molecular score: QTL 1 weighted 3 

Find Individuals on Molecular Score Table 

The Find ID dialog box can be used to search and locate a specific individual in the panel. Select Find and 

enter 242.   
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Filter Molecular Score Table 
The QTL/Individuals dialog is used to enable or disable the display of QTL and/or individuals on the MS table. 

Press the View button to display the filter dialog. Select and check QTL and/or individuals to follow. Select OK 

to apply the corresponding filter and immediately refresh the MS table. This new view of the MS table can be 

useful if you are working with a large number of QTL and/or individuals and you want to focus on specific 

QTL/plants. 

 

Selection 
The selection features are accessed by choosing Selection. Genetic value predictions can be used in three 

different ways to inform selections: 

 Manually select individuals based on own judgment 

 Truncated selection based on molecular score (MS), weighted MS, or the utility criterion (UC). 

 QTL complementation selection which aims to prevent the loss of rare favourable alleles 

Access Selection Functions by clicking Step 2 from the left menu. 
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Manual Selection 
Create a custom list of germplasm with high weighted molecular scores, but without fixation at QTL1. 

Double click the following lines and add to List Selection 1: 

 B124 

 B125 

 B47 

 B57 

 B110 

 B123 

 B93 

 B109 

 

Access List Selection 1 through the Selection Window. Double click on "List Section 1" and rename "Manual 

Selection" 

 

Truncation Selection 

Truncated selections are automatically made bases on Molecular score (MS), weighted (MS) or utility criterion 

(UC). Set the truncation selction paramenters. Select 8 lines (N
sel

) based on molecular score (MS). Rename 

"List Selection 2",  "Truncation." Select the Truncation list and click run. 
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QTL Complementation Selection 
QTL complementation selection aims to prevent the loss of rare favourable alleles, and is recommended when 

high numbers of QTL are being considered.  QTL complementation adds individuals that complement a list 

previously created by truncation selection.  

From the Selection window add a new list titled, "QTL Complementation".  Select this list for QTL 

complementation and click Option. 

 

Set N
max to 8. Leave the other options in their default settings. Select Apply and Run QCS. 

 

 
Two individuals, B8 and B124 have been identified by QTL complementation selection. B124 was not 

identified by truncation selection. 
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Create a combined list of the 9 individuals selected by truncation selection and QTL complementation. Add a 

new list and name it "Selections." Drag and drop the unique lines to the new list. 

 

Graphs 
The Graphs tab allows for further comparisons of selection criteria. 

 
The left graph shows that all 8 individuals selected through truncation will carry the unfavourable allele at 

QTL1.  The right graph on the includes the one individual, B124, added via the QTL complementation 

procedure that carries the favorable allele. 

Selection Pedigrees 
Pedigree illustration allows for easy visualization of the genetic contribution of selected individuals over 

generations. 

To display the pedigree illustration, choose the Selections list and indicate Alone to only display selected 

individuals. Click Generate. 

 
Pedigree of 9 Individuals Selected based on truncation and QTL complementation selection. 
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Intermating 
Identify crosses to initiate the next round of marker-assisted selection using one of three design methods. 

 The half-diallel complete method identifies crosses among all selected plants in a list 

 The better half method identifies crosses within a list, while avoiding crosses between selected 

individuals with low genetic values 

 Factorial Design Method: identifies crosses between two selection lists 

Select the Intermating functions by selecting Step 3 from the left menu. 

 

Half-Diallel Complete Method 
The half-diallel complete method identifies crosses among all selected plants in a list. Name an empty 

intermating list, Half-diallel. Choose the Selections list of 9 individuals selected based on truncation and QTL 

complementation selection. Select the Complete method option and click Apply. Assign the output to the Half 

Diallel list. Select Run.

        

36 crosses generated by the half-diallele method on the list of 9 individuals selected based on truncation and 

QTL complementation selection 
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Better Half Method 
The better half method identifies crosses within a list, while avoiding crosses between selected individuals 

with low genetic values. Name an empty intermating list Better Half. Choose the Selections list of 9 individuals 

selected based on truncation and QTL complementation selection. Select the Better Half method option. 

Select Run. 

 

 
20 crosses generated by the better half method on the list of 9 individuals selected based on truncation and 

QTL complementation selection 
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Factorial Intermating Design 
Intermating designs can be created using two selection lists by populating the additional list option. Cross the 

Manual selection (n=8) list with the Selection (n=9). 

 

 
72 crosses generated by the factorial method on the list of 9 individuals selected based on truncation and QTL 

complementation selection and 8 individuals manually selected 
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Program Administration 

Manage Program Settings 

Manage Program Settings allows you to edit the program settings established when the program was added 
(see Add & Manage Programs) and to delete existing programs.  

 

Deleting a program will result in permanent data loss.  Backing up the program before deleting will ensure that 
the data can be restored. 

 

Backup Program 
Frequently backup your programs to protect against accidental data loss. Use the restore function to restore 

your actual data or to follow along with tutorial instruction. 
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Backup programs will be automatically saved as .sql files within C:\Breeding Management System\ backup 

folder.  However, uninstalling the BMS will result in the loss of all files within C:\Breeding Management 

System.  Regularly copy backup files to additional locations and computers, particularly before updating or 

uninstalling the software. 

 

Restore Program 
Select a program database (.sql file) and select Preform Restore.  

User-Added Tools 

The Breeding Management System allows users to add custom user tools to the workbench. Please 
contact support@vsni.co.uk for support using this function. 

 

Data Import Tool 
The data import tool allows users to upload historical field observations from Excel files into the Breeding 

Management System. The Data Import Wizard is the most flexible way to import historical data from trials and 

nurseries.  Importing from Fieldbook formatted Excel files is the simplest way to import, but only useful if you 

have been using a standalone Fieldbook to manage your trials and nurseries. 
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Data Import Wizard 

Select the Data Import Wizard, and choose an excel file to import. The rice example (.xls) illustrated here can 
be replicated within a rice program. See below for file format details. Specify the observation sheet containing 
the phenotypic data within the Excel file. If the file only has one sheet of data there will be only one 
observation sheet option. 

 

Select the appropriate row of column headings and Close. 
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Enter a Study Name, Title, and Type. Select Next. Expect to wait a few seconds for initial mapping to 

complete. 

 

Map Excel Column Headers to Database Ontology 

The BMS will attempt to map the Excel sheet column headers to their corresponding database terms. 

Carefully review mapped selections, highlighted in blue, to ensure that ontology term chosen by the system 

truly matches the meaning and measurement of the imported data. 

 
In this example, the BMS has mapped 7 of the 10 columns of data. These 7 will need to be carefully reviewed, 
and the 3 unmapped columns of data will need to be manually matched to the database ontology. 
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Review the details of the suggested matches by selecting the Re-Map icon. Search for alternative matches if 

the scale or method for the selected match is different than the actual experimental design. Obtain the details 

of an alternative variable name by highlighting and selecting. 

 
If the alternative term is an actual match, select Apply Mapping. If a match is not found, select Add a Standard 
Variable, which takes you to the Ontology Manager. 

 

If the alternative term is an actual match, select Apply Mapping. The change will be reflected on the main 
screen.  
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Drag and Drop selected Un-Mapped terms to their appropriate group: Trial Environment, Germplasm Entry, or 

Variate. 

 
In this example, the Un-Mapped term, Name, describes germplasm entries and should be included with the 
Germplasm Entry group on the right. Days to Flower and Height are variates (phenotypic observations). 

Apply mapping to the un-mapped terms by manually searching for the appropriate term. 
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Select Save Mapping when mapping is complete or if the user will complete mapping at a later time. 

 

When mapping is complete, select Confirm Header Mapping. 

 

Ontology mapping is complete. Import the project data by selecting continue or return to the upload page to 
add more sheets of data to the trial. 
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Select the first row of data and import the observations. The phenotypic observations for this trial are now 
saved in the program database. 

 

The phenotypic observations for this trial are now saved in the program database. 

 

Excel File Format for Import Wizard 
Only one sheet of observation data can be read at a time. Two columns of descriptive data are required to 

import phenotypic observations: TRIAL_INSTANCE and ENTRY_NO.  Trial instance is a numerical 

identification of an individual experiment within a multisite or multiyear trial. For example, data from a single 

site or nursery will all have the same trial instance value. Entry number is a digit unique to each entry. For 

example, a trial containing three replicates of 50 accessions, will have the entry numbers 1-50 replicated three 

times. However you will probably also want to include additional descriptive data. If you plan to complete a 

single site phenotypic analysis you will need to include replication (REP). You will probably also want to import 

a column of germplasm names that are meaningful to your program to ease the interpretation of results. 

Full database integration requires that every germplasm have a GID. Without GIDs, the imported phenotypic 
data will not relate to phenotypic data outside of this trial or to other database information, like genotype and 
pedigrees. Full database integration requires that you first import the germplasm list into the database 
and assign GIDs to all germplasm. 

 
This data import sheet (.xls) contains the required entry number and trial instance columns, but also contains 
additional descriptive information: germplasm name, GID, plot number, and replication. This sheet also 
contains four columns of phenotypic data: heading date, yield, days to flower, and plant height. 
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Data Import from Fieldbook Formatted File 

Excel files generated by exporting from the BMS or the standalone IB Fieldbook are formatted for import into 
the BMS. Select a Fieldbook formatted Excel file and Submit. 

 

Fieldbook file import is complete.  Return to the upload page to upload additional files. 

 


